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These are me and my creatures These are me and my creatures 
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This is my garden This is my garden 
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IntroductionsIntroductions
Dr. Steffi LaZerte

Background in Biology (Animal Behaviour)
Working with R since 2007
Professional R programmer/consultant
since 2017

 Community AssistantrOpenSci
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IntroductionsIntroductions
Dr. Alex Koiter (Today’s Teaching Assistant)

Physical Geographer
Working with R since 2010
Associate Professor in Geography and Environment,
Brandon University
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What about you?What about you?
Name
Background (Role, Area of study, etc.)
Familiarity with R or Programming
Creatures (furry, feathery, scaley, green or otherwise)?
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About this WorkshopAbout this Workshop
Format

I will provide you tools and workflow to get started with R
We’ll have hands-on activities, lectures, and demonstrations
Video on or off, however works best for you!

Questions
Ask questions by un-muting, or ask in the chat (Alex will monitor)

Workshop-related questions we’ll address together
Specific, system-related problems, Alex will help you in the “Troubleshooting Room”

Getting help
Share your screen
Share your code

In chat
Or in a community notebook: https://collabedit.com/kxyap
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R is hard: But have no fear!R is hard: But have no fear!

Copy/Paste is your friend (never apologize for using it!)
Consider this workshop a resource to return to

Don’t expect to remember everything!
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What is R?What is R?
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RStudio vs. RRStudio vs. R

RStudio is not R
RStudio is a User Interface or IDE (integrated development environment)

(i.e., Makes coding simpler)

 

RStudio

 

R
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Open RStudioOpen RStudio
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R is a Programming languageR is a Programming language

You need to know the language (i.e., the code)
Computers don’t know what you mean, only what you type (unfortunately)
Spelling, punctuation, and capitalization all matter!

For example
R, what is 56 times 5.8?

A programming language is a way to give instructions in order to get a computer to do something

56 * 5.8
[1] 324.8
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Use code to tell R what to doUse code to tell R what to do

R, what is the average of numbers 1, 2, 3, 4?
mean(c(1, 2, 3, 4))

[1] 2.5

R, save this value for later
steffis_mean <- mean(c(1, 2, 3, 4))

R, multiply this value by 6
steffis_mean * 6

[1] 15
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Why R?Why R?
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R is hardR is hard
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But R is powerful (and reproducible)!But R is powerful (and reproducible)!
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R is also beautifulR is also beautiful
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R is affordable (i.e., free!)R is affordable (i.e., free!)
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Moral of the story?

Make friends, code in groups, learn together and don’t beat yourself up
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The GoalThe Goal
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About RAbout R
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Code, Output, ScriptsCode, Output, Scripts
Code

The actual commands

Output
The result of running code or a script

Script
A text file full of code that you want to run
You should always keep your code in a script

For example:
mean(c(1, 2, 3, 4))

[1] 2.5
Code

Output
Script

26



RStudio FeaturesRStudio Features
Projects

Handles working directories
Organizes your work

Let’s setup a project in
RStudio!

Changing Options: Tools > Global Options
General > Restore RData into workspace at startup (NO!)
General > Save workspace to on exit (NEVER!)
Code > Insert matching parens/quotes (Personal preference)

Let’s change some options
in RStudio!

Packages
Can use the package manager to install packages
Can use the manager to load them as well, but not recommended
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Getting ReadyGetting Ready
 Open New File

(make sure you’re in the RStudio Project)

 Write library(tidyverse) at the top

 Save this new script
(consider names like intro.R or 1_getting_started.R)
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Your first Your first realreal code! code!
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First CodeFirst Code

1. Copy/paste or type this into the script window in RStudio
You may have to go to File > New File > R Script

2. Click on the first line of code

3. Run the code
Click ‘Run’ button (upper right) or
Use the short-cut Ctrl-Enter

4. Repeat until all the code has run

# First load the packages1
library(palmerpenguins)2
library(ggplot2)3

4
# Now create the figure5
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +6
  geom_point()7
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First CodeFirst Code
# First load the packages1
library(palmerpenguins)2
library(ggplot2)3

4
# Now create the figure5
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +6
  geom_point()7

Warning: Removed 2 rows containing missing values (`geom_point()`).
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First CodeFirst Code
# First load the packages1
library(palmerpenguins)2
library(ggplot2)3

4
# Now create the figure5
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +6
  geom_point()7

Warning: Removed 2 rows containing missing values (`geom_point()`).

Packages
ggplot2 and palmerpenguins
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First CodeFirst Code
# First load the packages1
library(palmerpenguins)2
library(ggplot2)3

4
# Now create the figure5
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +6
  geom_point()7

Warning: Removed 2 rows containing missing values (`geom_point()`).

Functions
library(), ggplot(), aes(),

geom_point()
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First CodeFirst Code
# First load the packages1
library(palmerpenguins)2
library(ggplot2)3

4
# Now create the figure5
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +6
  geom_point()7

Warning: Removed 2 rows containing missing values (`geom_point()`).

+
(Specific to
ggplot)
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First CodeFirst Code
# First load the packages1
library(palmerpenguins)2
library(ggplot2)3

4
# Now create the figure5
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +6
  geom_point()7

Warning: Removed 2 rows containing missing values (`geom_point()`).

Figure!
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First CodeFirst Code
# First load the packages1
library(palmerpenguins)2
library(ggplot2)3

4
# Now create the figure5
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +6
  geom_point()7

Warning: Removed 2 rows containing missing values (`geom_point()`).

Warning
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First CodeFirst Code
# First load the packages1
library(palmerpenguins)2
library(ggplot2)3

4
# Now create the figure5
ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +6
  geom_point()7

Warning: Removed 2 rows containing missing values (`geom_point()`).

Comments
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R Basics: ObjectsR Basics: Objects
Objects are things in the environment

(Check out the Environment pane in RStudio)
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functions()functions()
Do things, Return things

Does something but returns nothing

e.g., library() - Loads an R package so we can use it’s functions and other objects it supplies

Does something and returns something

e.g., ggplot() - Creates and returns a basic plot

library(palmerpenguins)1

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm))1
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functions()functions()
Functions can take arguments (think ‘options’)
data, x, y, colour

ggplot(data = penguins, aes(x = body_mass_g, y = bill_length_mm, colour = species)) +1
  geom_point()2

Arguments defined by name or by position
With correct position, do not need to specify by name By name:

By order:

mean(x = c(1, 5, 10))1
[1] 5.333333

mean(c(1, 5, 10))1
[1] 5.333333

42

http://127.0.0.1:7573/1_intro_to_R_answers.html?print-pdf
http://127.0.0.1:7573/1_intro_to_R_answers.html?print-pdf
http://127.0.0.1:7573/1_intro_to_R_answers.html?print-pdf
http://127.0.0.1:7573/1_intro_to_R_answers.html?print-pdf
http://127.0.0.1:7573/1_intro_to_R_answers.html?print-pdf
http://127.0.0.1:7573/1_intro_to_R_answers.html?print-pdf
http://127.0.0.1:7573/1_intro_to_R_answers.html?print-pdf
http://127.0.0.1:7573/1_intro_to_R_answers.html?print-pdf
http://127.0.0.1:7573/1_intro_to_R_answers.html?print-pdf
http://127.0.0.1:7573/1_intro_to_R_answers.html?print-pdf
http://127.0.0.1:7573/1_intro_to_R_answers.html?print-pdf
http://127.0.0.1:7573/1_intro_to_R_answers.html?print-pdf


functions()functions()
Watch out for ‘hidden’ arguments

By name:
mean(x = c(1, 5, 10, NA), 1
     na.rm = TRUE)2

[1] 5.333333

By order:
mean(c(1, 5, 10, NA), 1
     TRUE)2

Error in mean.default(c(1, 5, 10, NA), TRUE): 'trim' must be 
numeric of length one

This error states that we’ve assigned the argument trim to a non-valid argument

Where did trim come from?
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R documentationR documentation
?mean1
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DataData
Generally kept in vectors or data.frames (also tibbles)
These are objects with names (like functions)
Here are two built-in examples (part of R)

rows x columns



Vector (1 dimension) Data frame (2 dimensions)

Columns have different types of variables

month.name1
 [1] "January"   "February"  "March"    
 [4] "April"     "May"       "June"     
 [7] "July"      "August"    "September"
[10] "October"   "November"  "December" 

mtcars1
                     mpg cyl  disp  hp drat    wt  qsec vs
Mazda RX4           21.0   6 160.0 110 3.90 2.620 16.46  0
Mazda RX4 Wag       21.0   6 160.0 110 3.90 2.875 17.02  0
Datsun 710          22.8   4 108.0  93 3.85 2.320 18.61  1
Hornet 4 Drive      21.4   6 258.0 110 3.08 3.215 19.44  1
Hornet Sportabout   18.7   8 360.0 175 3.15 3.440 17.02  0
Valiant             18.1   6 225.0 105 2.76 3.460 20.22  1
Duster 360          14.3   8 360.0 245 3.21 3.570 15.84  0
Merc 240D           24.4   4 146.7  62 3.69 3.190 20.00  1
Merc 230            22.8   4 140.8  95 3.92 3.150 22.90  1
Merc 280            19.2   6 167.6 123 3.92 3.440 18.30  1
Merc 280C           17.8   6 167.6 123 3.92 3.440 18.90  1
Merc 450SE          16.4   8 275.8 180 3.07 4.070 17.40  0
Merc 450SL          17.3   8 275.8 180 3.07 3.730 17.60  0
Merc 450SLC         15.2   8 275.8 180 3.07 3.780 18.00  0
Cadillac Fleetwood  10.4   8 472.0 205 2.93 5.250 17.98  0
Lincoln Continental 10.4   8 460.0 215 3.00 5.424 17.82  0
Chrysler Imperial   14.7   8 440.0 230 3.23 5.345 17.42  0
Fiat 128            32.4   4  78.7  66 4.08 2.200 19.47  1
Honda Civic         30.4   4  75.7  52 4.93 1.615 18.52  1
Toyota Corolla      33.9   4  71.1  65 4.22 1.835 19.90  1
Toyota Corona       21.5   4 120.1  97 3.70 2.465 20.01  1
Dodge Challenger    15.5   8 318.0 150 2.76 3.520 16.87  0
AMC Javelin         15.2   8 304.0 150 3.15 3.435 17.30  0
Camaro Z28          13.3   8 350.0 245 3.73 3.840 15.41  0
Pontiac Firebird    19.2   8 400.0 175 3.08 3.845 17.05  0
Fiat X1-9           27.3   4  79.0  66 4.08 1.935 18.90  1
Porsche 914-2       26.0   4 120.3  91 4.43 2.140 16.70  0
Lotus Europa        30.4   4  95.1 113 3.77 1.513 16.90  1
Ford Pantera L      15.8   8 351.0 264 4.22 3.170 14.50  0
Ferrari Dino        19.7   6 145.0 175 3.62 2.770 15.50  0

rows x columns
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Your Turn: Vectors and Data framesYour Turn: Vectors and Data frames
Try out the following code…

Here we will make a vector and a data frame
What is the output in your console?
How does your environment change (upper right panel)?

Vectors Data frames

a <- c("apples", 12, "pears", 5, 8)1
a2

my_data <- data.frame(x = c("s1", "s2", "s3", "s4"),1
                      y = c(101, 102, 103, 104),2
                      z = c("a", "b", "c", "d"))3
my_data4
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Your Turn: Vectors and Data framesYour Turn: Vectors and Data frames
Try out the following code…

What does : do?
What does c() do?
Why use a comma with data frames?

Vectors

Use [index] to access part of a vector
Can access multiple parts at once

Data frames

x$colname to pull columns out as vector
x[row, col] to access rows/columns

a[2]1
a[2:5]     # What does : do?2
a[c(1, 3)] # What does c() do?3

my_data[3, ]   # Why the comma?1
my_data[3, 1]2
my_data[, 1:2]3
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Your Turn: Vectors and Data framesYour Turn: Vectors and Data frames
Try out the following code…

Vectors Data frames

a[2]1
[1] "12"

a[2:5]     # What does : do?1
[1] "12"    "pears" "5"     "8"    

a[c(1, 3)] # What does c() do?1
[1] "apples" "pears" 

my_data[3, ]   # Why the comma?1
   x   y z
3 s3 103 c

my_data[3, 1]1
[1] "s3"

my_data[, 1:2]1
   x   y
1 s1 101
2 s2 102
3 s3 103
4 s4 104
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MiscellaneousMiscellaneous

50



R has spelling and punctuationR has spelling and punctuation
R cares about spelling
R is also case sensitive! (Apple is not the same as apple)
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R has spelling and punctuationR has spelling and punctuation
Commas are used to separate arguments in functions

This is correct:

This is not correct:

mean(c(5, 7, 10))  # [1] 7.3333331

mean(c(5 7 10))1

>80% of learning R is learning to troubleshoot!
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R has spelling and punctuationR has spelling and punctuation
Spaces usually don’t matter unless they change meanings

Periods don’t matter either, but can be used in the same way as letters

(But don’t)

5>=6    # [1] FALSE1
5 >=6   # [1] FALSE2
5 >= 6  # [1] FALSE3
5 > = 6 # Error: unexpected '=' in "5 > ="4

apple.oranges <- "fruit"1
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Assignments and Equal signsAssignments and Equal signs
Use <- to assign values to objects

Use = to set function arguments

Use == to determine equivalence (logical)

a <- "hello"1

mean(x = c(4, 9, 10))1

10 == 10 # [1] TRUE1
10 == 9  # [1] FALSE2
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Braces/BracketsBraces/Brackets
Round brackets: ()

Identify functions (even if there are no arguments)

Sys.Date() # Get the Current Date1
[1] "2024-02-21"

Without the (), R spits out information on the function:

Sys.Date1
function () 
as.Date(as.POSIXlt(Sys.time()))
<bytecode: 0x561fe69e47b8>
<environment: namespace:base>

() must be associated with a function (Well, almost always)
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Square brackets: Square brackets: [][]
Extract parts of objects

LETTERS1
 [1] "A" "B" "C" "D" "E" "F" "G" "H" "I" "J" "K" "L" "M" "N" "O" "P" "Q" "R" "S"
[20] "T" "U" "V" "W" "X" "Y" "Z"

LETTERS[1]1
[1] "A"

LETTERS[26]1
[1] "Z"

[] have to be associated with an object that has dimensions (Always!)
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Improving code readabilityImproving code readability
Use spaces like you would in sentences:

is easier to read than

(But the same, coding-wise)

a <- mean(c(4, 10, 13))1

a<-mean(c(4,10,13))1
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Improving code readabilityImproving code readability
Don’t be afraid to use line breaks (‘Enters’) to make the code more readable

Hard to read

Easier to read

(But the same, coding-wise)

a <- data.frame(exp = c("A", "B", "A", "B", "A", "B"), sub = c("A1", "A1", "A2", "A2", "A3", "A3"), res = c(10, 1

a <- data.frame(exp = c("A", "B", "A", "B", "A", "B"), 1
                sub = c("A1", "A1", "A2", "A2", "A3", "A3"), 2
                res = c(10, 12, 45, 12, 12, 13))3
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Let’s go!Let’s go!
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